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Thank you for choosing our products!  

 

This manual gives a detailed introduction to the usage of 

FSCUT4000 laser cutting controller, including technical features and 

installation instructions etc. For CypCut laser cutting software 

operation, please refer to the CypCut user manual. For other matters 

you can contact us directly.  

 

Operating personnel should read the manual in detail which will 

be helpful for a better use of the product.  

 

Due to the continuous updating of product functions, the products 

you receive may differ from the statement in this manual in some 

respects. We apologize for any inconvenience it may cause.  
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1. Product Description  

1.1 Brief Introduction  

FSCUT4000 is a high performance laser cutting system of close-loop control 

developed by Shanghai Friendess Company. It is widely used in metal and non-metal 

laser cutting application, has gained wide popularity among users at home and abroad.  

This manual served as installation and operation guide for FSCUT4000 system.  

FSCUT4000 system hardware table:  

Item  Model  Qty.  

Motion control card  BMC1214  1 pcs  

I/O terminal board BCL3724  1 pcs  

62-pin cable (2m)  C62-2  1 pcs  

Servo cable (1.5m)  C15-1.5  4 pcs  

Control software  CypCut  1 pcs  

Wireless handheld remote  WKB  1 pcs  

NC panel (optional)  BCP5045  1 pcs  

 

1.2 Connection Diagram 

BMC1214 card adopts PCI interface. Dimension: 155mm*106mm. The socket 

(DB62M) on control card connects with BCL3724 I/O terminal by C62-2 cable. Wiring 

diagram shown below:  
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1.3 Technical Reference 
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Motor control 

signal  

Analog output of 4 servo axis ports, -10V—+10V. 

Encoder feedback channel of 4 servo axis ports, 10MHz.  

Dedicated signal inputs of origin, positive/negative limit 

and servo alarm for each axis. 

Dedicated signal outputs of servo enable and alarm reset 

etc., for each axis. 

 

 

Motion 

control 

performance  

Control cycle 1ms. 

S-type acceleration and deceleration with filter. 

Velocity look-ahead strategy, intelligent speed control at 

turning point. 

Local curvature analysis and speed restriction at curves. 

Auto smooth corner. 

Laser control signal  1 PWM signal, DIP switch(24V/5V as options) 

3 analog output ports of 0~10V  

1 analog input port of 0~10V  

I/O function 12 common input ports.  

20 output: 6 relay outputs and 14 thyristor outputs.  

Work environment Temperature: 0-55 Celsius degree  

Humidity: 5% ~ 90% no condensation  

Power supply 24V，2A  
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1.4 Control Card Installation  

1.4.1 Install steps  

 

Please wear anti-static gloves to prevent possible electrostatic 

damage to the motion control card.  

(1)  Power off computer, insert the control card into PCI socket, and fix the control 

card tightly;  

(2)  After start up computer, "Add Hardware Wizard" pops out and click "Cancel" 

button, as shown below. If this dialog box does not appear, indicating the card 

is in poor connection, please repeat the first step.  

 

(3)  Install CypCut software. The driver program will be installed by default option 

automatically.  

(4)  Open windows device manager to confirm installation succeed. Below image 

shows the installation is succeed.  
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1.4.2 Troubleshoot  

（1） If "Find New Hardware" dialog box does not pop out after start up computer 

or control card does not shown in device manager, indicating that the control 

card is not in good connection with PCI socket. Please replace the PCI socket 

or change another computer, insert the control card tightly and reinstall 

software.  

（2） If the device has a yellow exclamation mark, double-click  to 

open its attributes page, and select "Detail Information" as shown below:  

 

（3） If the first half of the ‘device instance ID’ attribute is displayed as

 it means computer has correctly recognized the motion 

control card but software installation might be failed. Try install CypCut 

again, if installation still fails, please contact our technical support.  

（4） If the first half of ‘device instance ID’ attribute is not , it 
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indicates computer doesn't recognize the control card. Power off computer and 

change PCI socket, install the card firmly and repeat installation again. 

（5） If step (4) still fails, the control card might be damaged please contact our 

technicians. 
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2. BCL3724 Wiring Instruction  

2.1 BCL3724 Description  

BCL3724 diagram shown as below:  
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You can either use guide rail or fixed installation to install BCL3724 board, product 

dimension 315mm*107mm. DB62M socket connected with JP1 interface of BMC1214 

card by C62-2 cable.  

4 sockets (DB15M) on top left are for servo control, from left to right is X, Y1, Y2 

and W axis port.  

The signal terminals on bottom left are positive/negative limit, origin inputs of X, 

Y and W axes. All lower terminals are conducted, ground end of COM, 0V.  

On bottom right are 20 common output terminals which are thyristor emitter output. 

Thyristor output is 24V, common cathode.  

Above are PWM signal and 4 DA analog signal terminals.  

There is a DIP switch down below PWM:  

Switch P1 and P2 to set PWM voltage  

P1  P2  Description  

On  Off  PWM voltage is 24V  

Off  On  PWM voltage is 5V  

2.2 Signal Type  

2.2.1 Input signal 

The input signals: positive/negative limit, origin, common input. All input 

terminals of BMC1214 are low-level active, support NO (normally-open) and NC 

(normally-close) input. When set input as normally-open, input signal active when 

conduct with 0V; when set input as normally-close, input signal active when disconnect 

with 0V. 

The polarity of input can be changed by jump-wire, IN10, IN11, IN12 support 

jump-wire. There are 2 status of jump-wire, ACT_LOW means low-level active (input 

0V active); ACT_HIGH means high-level active (input24V active). The default state is 

ACT_LOW. 
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The typical wiring of photo-electric switch shown below, must use NPN 24V type 

switch.  
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The typical wiring of contact switch shown below.  
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The typical wiring of magnetic switch shown below, must use NPN 24V type 

switch.  
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BCL3724 Magnetic switch

0V
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2.2.2 Relay output  

There are 6 relay output on BCL3724 terminal board which are OUT1-OUT6. 

OUT1-OUT4 only support normally open, OUT5-OUT6 have both NO and NC 

options. The maximum load of relay: DC 30V, 8A; AC 250V, 8A. Recommend to 

use load under 2A, the inductive load or high power load will reduce the service 

time of relay switch.  

Wiring between relay output and contact shown below:  

BCL3724

24VDigit

Machine

Co
il

 po
we

r 
su

pp
ly

OUT1

 

2.2.3 Thyristor output  

There are 14 thyristor output on BCL3724 from OUT7-OUT20, which can drive 

24V DC device directly, drive capacity is 500mA. Wiring diagram shown below:  

BCL3724

OUT16

COM

24V DC
Magnetic 
valve
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2.2.4 Analog output  

3 analog output of 0-10V.  

 

2.2.5 PWM output  

There is one PWM port on BCL3724 for laser average power modulation. There 

are 5V and 24V for options. The duty cycle is adjustable from 0%~100%, the highest 

carrier frequency 50 KHz. The signal output shown below:  

PWM+

PWM-

PWM 

VCC

 

Set PWM signal level, 5V or 24V set by DIP switch.  

2.3 I/O Specification 

2.3.1 External power supply  

BCL3724 requires external 24V DC power supply. The 24V and COM connect 

with 24V and 0V of power supply.  

2.3.2 Servo control port  

The 4 servo ports on BCL3724 are DB15 sockets, signal pin description listed 

Output range  0V~+10V 

Maximum output load  50mA 

Maximum capacitive load  350pF 

Input impedance  100KΩ 

Maximum bipolar error  +/-50mV 

Resolution  10mV 

Conversion speed  400us 
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below:  

1  2  3  4  5  6  7  8

9 10 11 12 13 14 15
 

 

The signal pin description of C15-1.5 cable listed below:  

15-pin servo control interface  

Pin  Description   Pin  Description  

1  DA (-10~10V analog)   9  AGND (analog ground)  

2  0S (zero speed clamp)   10  0V (power supply ground)  

3  A+ (encoder A phase positive)   11  A- (encoder A phase negative)  

4  B+ (encoder B phase positive)   12  B- (encoder B phase negative)  

5  Z+ (encoder Z phase positive)   13  Z- (encoder Z phase negative)  

6  SON (servo enable)   14  ALM (alarm signal)  

7  CLR (alarm clear)   15  0V (power supply ground)  

8  24V (power supply)     

+24V, 0V: give 24V DC power supply to servo driver;  

SON: servo-on output;  

ALM: alarm input from servo;  

DA, AGND: analog output for motor control;  

CLR: alarm reset;  

OS: zero speed clamp signal;  

A+ 、 A- 、 B+ 、 B- 、 Z+ 、 Z-: Encoder 3-phase input signal, to check 

encoder zero point.  

The polarity of SON and ALM can be changed by jump-wire;  

SON

ACT_LOW

ACT_HIGH

ALM

ACT_LOW

ACT_HIGH
 

SON signal jump wire to ACT_LOW, output is low-level active (output 0V active); 

Jump wire to ACT_HIGH, output is high-level active (output 24V active); Default is 

ACT_LOW. 
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ALM signal jump wire to ACT_LOW, input is low-level active (input 0V active); 

Jump wire to ACT_HIGH, input is high-level active (input 24V active); Default is 

ACT_LOW. 

2.3.3 Servo drive control signal 

The wiring diagram with Panasonic, Yaskawa, Sanyo and Schneider provided here. 

For servo driver parameter setting you can take reference from ServoTools calculation. 

If you have any question please contact our technical support.  

For other brand servo wiring please take notice of following items:  

(1) Make sure the servo supports velocity control mode. For example, Panasonic 

A5 series servo must choose full-function type, cannot use pulse type;  

(2) Check if SON signal is low-level active (SON is active when conducted with 

GND of 24V);  

(3) Check if there is external emergency stop in servo I/O;  

(4) Before trial run of driver, provide 24V power supply to IO terminal board, the 

24V power supply provided by BCL I/O board;  

(5) If driver still can't run, check if the parameter 'positive/negative direction drive 

inhibit' in driver is disabled.  
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Panasonic servo wiring diagram  

FSCUT DB15 servo control MINAS-A 50P

Signal Pin SignalPin

DA     1

AGND   9

A+    3

A-    11

B+    4

B-    12
Z+    5

Z-    13

24V    8

0V    10

ALM   14

14  SPR/TRQR

21     OA+
22     OA-

48     OB+

23     OZ+
49     OB-

24     OZ-

 7     COM+

36    ALM-

37    ALM+
41    COM-

Shielding layer

SON    6

15    GND

29   SRV-ON

0V    15

 

Panasonic A5 reference setting  

Parameter  Description  Recommended value 

Pr0.01  Control mode  1 

Pr0.02  Real time auto tuning  0 

Pr0.04  Inertia ratio  You can calculate the inertia ratio by 

Panasonic servo software 

Pr0.11  Encoder output pulse 

per motor revolution  

Set by mechanism feature, the pulse equivalent 

should be among 1000-2000. For example, if 

the linear distance is 10mm on machine load 

per motor rotation, the pulse per revolution 

should be 10000, and Pr0.11 set 2500. 

Pr1.01  1st gain of velocity 

loop 

75.0Hz 

Pr1.02  1st time constant of 

velocity loop 

integration 

9.0ms 

P r1.04  1st time constant of 

torque filter 

0.3ms 

P r3.02  Input gain of speed 

command  

Set by maximum motor speed. If maximum 

motor speed is 4000rpm, set 400 here.  
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Yaskawa servo wiring diagram 

FSCUT DB15 servo control YaskawaΣ50P

Signal Pin SignalPin

DA     1

AGND   9

A+    3

A-    11

B+    4

B-    12
Z+    5

Z-    13

24V    8

0V     10

ALM    14

5     V-REF

33     PAO 
34    /PAO

35     PBO

19     PCO 
36    /PBO

20    /PCO

 47   +24 VIN

32    ALM-

31    ALM+
1      SG

Shielding layer

SON    6

6      SG

40   /S-ON

0V     15

 

Yaskawa Sigma 5/7 reference setting  

Parameter  Description  Recommended value  

Pn000  Control mode  0000  

Pn100  Velocity loop gain  75.0Hz  

Pn101  Velocity loop integral 

constant  

9 .00 MS  

Pn103  Inertia ratio  Set by calculation result of Yaskawa 

servo software SigmaWin. Or you 

can set by calculation result of 

ServoTools.  

Pn170  Adjustment-free  1400  

Pn212  Differential pulse output 

per motor revolution  

Set by mechanism feature, the pulse 

equivalent should be among 1000-2000. 

For example, if the linear distance is 

10mm per motor rotation, the pulse per 

revolution should be 10000, and Pr0.11 

set 2500.  

Pn300  Input gain of speed 

command 

0.01V/rated speed  
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Pn401  Torque command filter 

time constant  

0.30 MS  

Pn50A  Input signal  8100  

Pn50B  Input signal  6548  
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Sanyo R series wiring diagram  

Signal Pin SignalPin

DA     1

AGND   9

A+    3

A-    11

B+    4

B-    12
Z+    5

Z-    13

24V    8

0V     10

ALM    14

21   V-REF

3      A0+
4      A0-

5      B0+

7      ZO+ 
6      BO-

8      ZO-

 50   CONT-COM  

24   OUT-COM

46   OUT8

SON    6

20     SG

FSCUT DB15 servo control Sanyo R2 50P

Shielding layer

 37   CONT1

 49   OUT-PWR  

 

Sanyo R2 reference setting  

Parameter   Description  Recommended value  

SY09  Control mode  01  

Gr0.00  TUNMODE, tuning mode selection.  02  

Gr1.12  KVP, velocity loop proportional 

gain  

75H z  

Gr1.13  TVI, velocity loop integral time 

constant  

9ms  

Gr1.14  Inertia ratio  Input the value calculated by Sanyo 

servo software, you can also 

calculate by Friendess ServoTools.  

Gr8.29  VCGN, analog velocity command 

gain  

Set by the maximum motor rpm. For 

example, if the maximum motor 

speed is 4000rpm, set this parameter 

as 4000.  

G r9.00  F-OT, forward over travel  00  

Gr9.01  R-OT, reverse over travel  00  

G r9.27  VLPCON, velocity loop  00  

G rB.13  Hold brake delay  00  
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G rB.14  Release brake delay  00  

G rC.04  Differential pulse output  Set by mechanism feature, the pulse 

equivalent should be among 1000-2000. 

For example, if the linear distance on 

machine load is 10mm per motor 

rotation, the pulse per revolution should 

be 10000, and Pr0.11 set 2500.  
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Schneider Lexium 23D wiring diagram 

FSCUT DB15 servo control Schneider Lexium 23D

Signal Pin SignalPin

DA     1

AGND   9

A+    3

A-    11

B+    4

B-    12
Z+    5

Z-    13

24V    8

0V     10

ALM    14

42  V-REF

21  OA
22  /OA

25  OB

50  OC
23  /OB

24  /OC

11  COM+

45  COM-

27  DO5-

Shielding layer

SON    6

44  GND

0V     15

28  DO5+

9   SON

 

Schneider 23D reference setting  

Parameter   Description  Recommended value  

P1-01  Control mode  0002  

P1-37  Inertia ratio  Input inertia ratio calculated by 

Schneider servo software, you can also 

use Friendess ServoTools to calculate the 

inertia ratio.  

P1-40  VCM, maximum command 

rotation speed  

Set by maximum RPM of motor. For 

example, if the maximum RPM of motor 

is 4000rpm, set same value for this 

parameter.  

P1-46  ENCOUTRES, encoder output 

pulse per motor revolution  

Set by mechanism feature, the pulse 

equivalent should be among 1000-2000. For 

example, if the linear distance is 10mm per 

motor rotation, the pulse per revolution 

should be 10000, and Pr0.11 set 2500.  

P2-04  KVP, velocity control gain  565rad/s  

P2-06  KVI, velocity integral 

compensation  

108rad/s  
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2.3.4 Origin and limit  

X-: negative limit of X axis, dedicated input, low-level active;  

XO: origin of X axis, dedicated input, low-level active;  

X+: positive limit of X axis, dedicated input, low-level active;  

COM: ground, the common end of above three signal ports.  

 

Y1-: negative limit of Y1 axis, dedicated input, low-level active;  

Y1O: origin of Y1 axis, dedicated input, low-level active;  

Y1+: positive limit of Y1 axis, dedicated input, low-level active;  

COM: ground, the common end of above three signal ports.  

 

Y2-: negative limit of Y2 axis, dedicated input, low-level active;  

Y2O: origin of Y2 axis, dedicated input, low-level active;  

Y2+: positive limit of Y2 axis, dedicated input, low-level active;  

COM: ground, the common end of above three signal ports.  

 

W-: negative limit of W axis, dedicated input, low-level active;  

WO: origin of W axis, dedicated input, low-level active;  

W+: positive limit of W axis, dedicated input, low-level active;  

COM: ground, the common end of above three signal ports.  

You can change input polarity of origin and limit signals via machine config tool. 

See details in chapter 3 machine config.  

2.3.5 Common input  

There are 12 common input IN1-IN12. You can assign common inputs as user-

defined software button or alarm input. See details in chapter 3 machine config.  

2.3.6 Common output  

There are 20 common output OUT1-OUT20. Common output can be assigned as 

user-defined signal output for laser, gas, indicator lamp controlling etc. See details in 

chapter 3 machine config.  

P 2-32  ATMODE, automatic 

adjustment  

0  
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2.3.7 Analog output  

3 channels analog output of 0-10V, DA1, DA2 and DA3. Analog output can be 

assigned for laser peak power and gas valve control.  

2.3.8 PWM output  

For fiber laser configuration in CypCut machine config, PWM will be activated 

automatically for laser average power regulation. For other type laser, there is no signal 

output from PWM port.  
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2.4 Wiring Diagram  

DB15 socket

X servo

Y1 axis
W axis

DB15 socket
DB15 socket

X xis

DB62 socket

+24V
COM

24V power 
supply

Control relay

X-
X0
X+
COM

X- limit

X origin

X+ limit

Y1- limit

Y1 origin

Y1+ limit

Y1-
Y10
Y1+
COM

PWM-
PWM+

DA1-
DA1+

DA2-
DA2+

PWM
output

Analog 
output1

Analog 
output2

Laser 
modulation

Laser

Proportion
al valve

Analog GND

Analog voltage

Analog GND

Analog voltage

IN12
IN11
IN10
IN9
IN8

IN7
IN6
IN5
IN4

IN3
IN2
IN1
COM

Custom input

Thyristor output

OUT20

COM

DC 24V 
output

Y1 servo

DB15 socket

Y2 servo
W servo

DA3-
DA3+

AD1-
AD1+

Y2-
Y20
Y2+
COM

W-
W0
W+
COM

Y2 axis

OUT7

OUT4

OUT1

NO type
contact

OUT6

OUT5

NO/NC type 
contact

Relay output

Gas pressure 
valve

Analog GND

Analog voltage

Analog 
output3

Analog 
input1
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2.5 Laser Wiring Diagram  

2.5.1 YAG laser 

Assign an output for laser emission and connect with laser.  

2.5.2 CO2 laser 

Here take example of NT-3200SM CO2 laser.  

OVNT CO2 laser 24P

6

7 Analog 0V

BCL3724_V2.0 Terminal Board

DA1-

DA1+

OUT11

OUT13

Analog output

11

12

Optical shutter

Optical shutter

Assign one relay 
output as mechanical 

shutter

NO

CON

Laser power

Thyristor output

OUT14

COM

10

8 EP pulse

Digital shutter

SP pulse

Switching value 0V

9

19

16

18

Shutter response

Passive CON

Assign one input for 
mechanical shutter response

IN

COM

Note: mechanical 
shutter response is 
not necessary.

(DA1 laser power control)

    OUT11 digital shutter

    OUT13 laser mode1

    OUT14 laser mdoe2

 

Note:  

Some of CO2 laser also supports PWM control mode, wiring can take reference 

from Max laser.  
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2.5.3 IPG-YLR 

 

1

2

3

4

IPG_YLR Laser 25P

Safety interlock1

Safety interlock2

Safety interlock2

Safety interlock1

5

6

7

15

16

Computer RS232 DB9

1

2

3

4

5

6

7

8

9

RS232 Rx

RS232 Tx

RS232 COM

Modulation+

Modulation-

BCL3724_V2.0 I/O Board

PWM 
output

1 2 

DIP switch
ON

PWM-

PWM+

 

 

It's recommended to use serial communication (RS232) or network 

communication under serial or Ethernet communication, CypCut can monitor laser 

status in real time and control laser of emission, aiming, peak power without DA analog 

output.  

Recommend to use network communication for IPG-YLR series.  

Note:  

1. Remote start-up button is not necessary and not recommended for it might cause 

laser malfunction when laser is not well grounded.  

2. Select 24V for PWM (DIP switch: PIN1 ON, PIN2 OFF).  
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2.5.4 IPG_ YLS Germany 

IPG-Germany YLS Laser

A1

A2

Modulation+

Modulation-

BCL3724_V2.0 I/O Board

PWM-

PWM+

PWM 
output

A1

A2

0~10V

AGND

DA1-

DA1+

A1

A2

Laser Request

Program Start

7Pin XP4

25Pin XP2

64Pin XP1

Analog output
（DA1 for laser power control）

C1 Laser ONOUT11

OUT12

 thyristor output

OUT13

OUT14

     OUT11 Laser ON

     OUT12 Laser Request

     OUT13 Program Start

     OUT14 Aiming A5

A16

B15

B16

A6

COM

Guide Laser On

Common

+24V

COM

+24V

Anolog Control ON

24V

0V

Power output

B2 Emission ON

COM

Assign an input as 
Emission  Status）

24V reply

IN

C1

C2

C3

C4

Safety interlock1

Safety interlock2

Safety interlock2

Safety interlock1

1 2

DIP switch
ON

 

Note:  

1. B2 'Emission ON' in XP1 interface is not necessary for CypCut, set 'Emission 

Status' as '0' in machine config, CypCut will not check laser emission status.  

2. Select 24V for PWM (DIP switch: PIN1 ON, PIN2 OFF).  
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2.5.5 IPG_ YLS American 

IPG-American YLS Laser

A1

A2

Modulation+

Modulation-

BCL3724_V2.0 I/O Board

PWM output

A1

A2

0~10V

AGND

DA1-

DA1+

A1

A2

Laser Request

Program Start

7Pin XP4

25Pin XP2

64Pin XP1

Analog output
DA1 laser power cotrol

OUT11

OUT12

 Thyristor output

OUT13

 OUT11 Laser Request

 OUT12 Program Start

 OUT13 Aiming A5

A16

B15

B16

A6

COM

Guide Laser On

Common

+24V

COM

+24V

Anolog Control ON

24V

0V

Power output

B2 Emission ON

COM

Assign a output 
Emission Status

24V relay

IN

A8

A9

NO

CON
Assign an output for 

Laser On

C1

C2

Remote Mode

Remote Mode

Power On

Power On

C3

C4

C5

C6

Safety interlock1

Safety interlock2

Safety interlock2

Safety interlock1

PWM-

PWM+1 2 

DIP switch
ON

Note: 

1. B2 'Emission ON' in XP1 interface is not necessary for CypCut, set 'Emission 

Status' as '0' in machine config, CypCut will not check laser emission status.  

2. Select 24V for PWM (DIP switch: PIN1 ON, PIN2 OFF).  



31 FSCUT4000 Laser Cutting Control System  
 
   

2.5.6 SPI-500W-R4 

1

2

4

5

SPI-500W R4 Laser Systems

Interlock 1

Interlock 2

Interlock 2

Interlock 1

2

3

5

Computer 
RS232 DB9

1

2

3

4

5

6

7

8

9

RS232 Rx

RS232 Tx

RS232 COM

Modulation+

Modulation-

BCL3724_V2.0 I/O Board

PWM-

PWM+

PWM 
output

InterLock

RS232 Comms Port

Mod Input TTL

1 2

DIP Switch

ON

 

Note:  

1. When use MODINPUTTTL for laser modulation, select 5V for PWM (DIP 

switch: PIN1 OFF, PIN2 ON).    

2. When use PIN1 of I/O interface for laser modulation, select 24V for PWM (DIP 

switch: PIN1 ON, PIN2 OFF).  

 

 

 



 
FSCUT4000 Laser Cutting Control System  32 

 

2.5.7 FEIBO MARS 

FEIBO MARS-500W Laser System

+5v

INTLK

2

3

5

Computer RS232 DB9

1

2

3

4

5

6

7

8

9

RS232 Rx

RS232 Tx

RS232 COM

Modulation+

Modulation-

BCL3724_V2.0 I/O Board

PWM-

PWM+

PWM 
output

D-SUB 9

D-SUB 15

1 2

DIP Switch

ON 3

6

8

9

 

Note:  

Select 24V for PWM (DIP switch: PIN1 ON, PIN2 OFF).  
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2.5.8 JK/GSI-FL 

1

2

5

6

JK/GSI-500W-FL

Interlock

Interlock

2

3

5

Computer RS232 DB9

1

2

3

4

5

6

7

8

9

RS232 Tx

RS232 Rx

RS232 COM

Modulation+

Modulation-

BCL3724_V2.0 I/O Board

PWM-

PWM+

PWM 
output

SK11

PL1

SK101

7

15

14

13

10

9 Interlock

Interlock

Interlock

Interlock

Interlock

Interlock

Interlock

Interlock

 

Note:  

1. The interlock in SK11 interface  

2. When use SK101 as modulation, select 5V for PWM (DIP switch: PIN1 OFF, 

PIN2 ON).  

3. When use Pin-16 in PL5 as modulation, select 24V for PWM (DIP switch: PIN1 

ON, PIN2 OFF).  
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2.5.9 Rofin 

Rofin Fiber Laser

22

23

BCL3724_V2.0 I/O Board

PWM 
output

1

14

Analog+

Analog-

DA1-

DA1+

3

1

Mains on

Program Start

X704

X720

X710

Analog output
DA1 laser power control

OUT11

OUT12

Thyristor output

OUT13

     OUT11   Mission ON

     OUT12   Fault Reset

     OUT13   Stand By

     OUT14   Aiming

     OUT15   Gate

4

8

15

9

OUT14 Guide Laser On

Ext GND

Ext Pulse 5V

24

25

26

27

28

29

30

31

Interlock

Interlock

Interlock

Interlock

PWM-

PWM+

32

33

Interlock

Interlock

Interlock

Interlock

Interlock

Interlock

Interlock

Interlock

OUT15

COM

10 Gate

Stand By

13 Gate GND

16 Ext Pulse GND
1 2 

DIP switch
ON

 

Note:  

1. Take related reference for wiring of interlock in X720;  

2. Select 5V for PWM ((DIP switch: PIN1 OFF, PIN2 ON; one of PIN3 or PIN4 

ON and the other OFF).  
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2.5.10 Raycus 

b

c

RayCus Fiber Laser

Interlock1

Interlock1

2

3

5

Computer RS232 DB9

1

2

3

4

5

6

7

8

9

RS232 Rx

RS232 Tx

RS232 COM

Modulation+

Modulation-

BCL3724_V2.0 I/O Board

PWM-

PWM+

PWM 
output

InterLock

COMMAND RS232

INPUT MOD

 

Note:  

1. Raycus's latest products use 24V PWM, the old versions use 5V PWM. For 

latest Raycus laser, key switch turns to REM under serial communication, while for 

old versions key switch turns to ON position under serial communication. Laser 

PWM port will indicate its 24V or 5V control. No specific description indicates 5V 

PWM control.  

2. 5V PWM control (DIP switch: PIN1 OFF, PIN2 ON).  

3. 24V PWM control (DIP switch: PIN1 ON, PIN2 OFF).  
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2.5.11 Max  

Max Fiber Laser

Water chiller interlock

Water chiller interlock

Modulation+

BCL3724_V2.0 I/O Board

PWM-

PWM+

PWM 
output

InterLock

1 2 

DIP Switch
ON

OUT18

COM

Emission on+

Emission on- 
Aiming-

Assign thyristor output as 
Emission on and Aiming

Modulation-

IN

COM

PD+

PD-

OUT17 Aiming+

Max Fiber Laser

Assign one input as 
laser alarm

DA1-

DA1+
AGND

0~10V

Analog output
DA1 laser power control

1

19

3

15

17

16

21

22

5

12

18

23

 

 

Note:  

1. PD+/PD-(laser alarm output) connect to any input port in BCL3724 I/O board, 

then in 'machine config>alarm>custom alarm' setup the laser alarm (normally-open);  

2. The ground end of aiming laser and laser emission can connect to any COM 

port in BCL3724 board.  

3. 24V PWM control (DIP switch: PIN1 ON, PIN2 OFF; one of PIN3 and PIN4 is 

ON, the other is OFF).  
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3. Machine Config Tool  

3.1 Installation and Operation  

CypCut default installation contains machine config program.  

In Windows Start > All Programs > CypCut open machine config program . 

'CypCut laser cutting system' is software name which might be different of OEM 

version.  

3.2 Password  

You have to input password to start config tool.  

 

 

Initial password 61259023.  

 

Note:  

All settings in machine config must setup by actual mechanism structure. Wrong 

settings will cause severe unknown problem! In machine config, all input are yellow 

color, and all output are green color.  
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3.3 User Interface  

 

 

The first page open machine config is machine config overview. Click tab in top 

and left bar will open each parameter setup page for different machine module. For 

example, above three are entrance for laser, height control and gas system setting page. 

Click 'file location' will locate to folder of config data.  

Click button in overview page will also open the parameter setting page of each 

module. Click 'Machine tool' will enter ' Machine' page.  

Click 'import' to finish machine config setting by existing file. Click 'save' save the 

setting.  

 

Note:  

1. Data folder contains all config files of CypCut.  

2. Data backup is in CypCut > File > Backup.  
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3.4 Mechanism Config  

 

Config mechanism structure, single drive Y axis or dual-drive Y axis, also config 

rotary axis.  

 

X axis range: the maximum travel range under software limit protection function, 

also the width of white frame in CypCut drawing board.  

Y axis range: the maximum travel range under software limit protection function, 

also the length of white frame in CypCut drawing board.  

Pulse equivalent: pulse output per 1mm linear distance on machine load. You can 

calculate by ServoTools.  

Servo alarm: set the triggered polarity of alarm signal is normally open or close.  

Max speed: maximum user speed and acceleration restricted by CypCut.  

Pitch compensation: compensation method for mechanic error including backlash 
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and offset error data from interferometer.  

Squareness: this is to offset the error when X and Y mechanic is not orthogonal.  

X/Y check: used for motor runaway risk checking.  

 

Motor runaway check: to check if the motor rotation direction same with encoder 

feedback. For example: send voltage+ for motor rotation+. If encoder feedback pulses 

increase in positive value, it indicates motor rotation polarity same with encoder 

feedback. Otherwise, it cannot create a close loop control when motor rotation polarity 

different with encoder feedback, under this situation motor will never reach the target 

position and controller keep sending command signal, machine load will rush out, this 

scenario called 'motor runaway'. (Note: if doesn't pass motor runaway test, cannot open 

CypCut for machine spindle adjust).  

The sequence of motor runaway check:  
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V

100ms 50ms

100ms t

-30rpm

30rpm

 

Close-loop jog: check the option and jog X axis, observe the motor rotation and 

encoder feedback polarity.  

Open-loop jog: check the option controller only send analog output, doesn't 

compare with feedback. Dual-drive axis doesn't recommend this function.  

Reverse X: if machine load direction not same with jog direction, click 

 to reverse it and doesn't need to change setting in servo driver.  

Pulse check: check if encoder feedback pulses match with controller command.  
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3.5 Return Origin Config  

 

 

Enable soft limit: check this option, software limit function will force start all the 

time.  

Prompt user at start: prompt message when open CypCut to inform user execute 

return origin operation.  

Origin direction: select return origin direction needed. Return origin direction 

decides which coordinate quadrant system runs with. For example, return origin 

direction of X and Y are both in negative direction, system runs in first quadrant 

coordinate.  

Origin signal: FSCUT4000 must use origin switch, cannot take limit as origin.  

ORG measure: measure the installation distance between limit and origin switch.  

Z-phase signal: whether or not capture Z-phase signal results different return 
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origin process. The return origin process of each mode will display in picture. Dual-

drive gantry synchronize function only available when capture Z-phase signal return 

origin.  

Low speed: fine positioning speed, recommend to set 10mm/s.  

High speed: course positioning speed, recommend to set 50mm/s.  

Rollback: the distance motor rolls back after reach origin switch.  

Limit logic: the polarity of limit and origin signal active.  

3.6 Laser Configuration  

CypCut programmed standard configuration for YAG, CO2, IPG, Raycus, SPI and 

many other brand laser, select laser type and there are different parameter settings under 

each page.  

3.6.1 CO2 laser configuration  

 

Mechanic shutter: the output for mechanic shutter.  

Digital shutter: the output for digital shutter.  

Response input: response input when open mechanic shutter.  
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Laser form: laser form can be set as continuous wave, gate pulse and high power 

pulse by mode 1 and mode 2 output.  

DA port: there are three DA analog output, select one of them for laser power 

control.  

DA range: set the analog voltage range.  

Minimum power: the minimum laser power.  

3.6.2 IPG laser configuration  

 

PWM enable: select a relay output in BCL3724 board as switch of PWM signal. 

Relay output can avoid laser leakage.  

DA output: there are 3 DA ports of analog output, select one of them for laser 

power control. When use RS232 or network control doesn't require DA port.  

 

IPG Fiber Laser Configuration:  

Remote start button:  

When key switch turns to remote control mode, you can startup laser by remote 
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button. If use remote start button, you need to setup the output port for the button. 

(Remote start up button is not recommended, for it's easy to cause laser malfunction).  

IPG remote control:  

When use IPG remote control, CypCut will monitor laser status in real time, then 

communicate and control laser emission, guide beam and peak current etc. When use 

remote control mode, doesn't require DA analog port.  

IPG remote control supports serial and network communication, user can set IP or 

COM port as needed. When laser and BCS100 both select network communication with 

PC, take notice that the network segment of each IP cannot be same. For example, IP 

segment of BCS100 is 10.1.1.x while laser IP set 192.168.1.x. Recommend to use 

network communication which is more stable. If use serial communication, the 

shielding layer and outer shell of the connected device must be well grounded.  

3.6.3 Feibo/Rofin/SPI/GSI/JK laser configuration  

 

 

Feibo, Raycus and SPI laser are similar with IPG laser configuration, and support 

serial communication.  

Debug mode: when enable this mode, CypCut log window will display the 

communication code with laser.  
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3.6.4 Configuration of other laser type 

 

Shutter enable: output to open laser shutter.  

3.7 BCS100 Configuration  

3.7.1 Use BCS100 as height control unit  

 

 

Use BCS100 as height control unit, set IP address in machine config same in 

BCS100.  

Details of setting IP address please check in BCS100 user manual P2.5.6.  
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3.7.2 Use external device as height control unit  

 

CypCut supports I/O control mode for height controller of other brand. User can 

assign output with basic functions of lift, hold, up and down etc.  

Start follow: output to start follow.  

Lift/stop follow: output of stop follow and lift up.  

Stop/hold: output of stop follow and hold still.  

Jog up: output of jog Z axis up.  

Jog down: output of jog Z axis down.  

Follow in place: input signal of follow reached position.  

Active level (follow in place input): active level of follow in place signal.  

Note: If the port number set '0', means this port not in use. If this port not assigned 

to any signal, doesn't set any port number, otherwise it might cause error.  
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3.8 Gas System  

Valve (H/L): master valve of high pressure or low pressure gas channel.  

Air: set output for air switch.  

Oxygen: set output for oxygen switch.  

Nitrogen: set output for nitrogen switch.  

Gas alarm: to set alarm check for each gas channel or master valve.  

There are 3 DA ports of analog signal can be assigned for gas pressure regulation.  

3.9 Alarm Configuration  
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3.9.1 Warning message  

Display the warning message of yellow color when machine is running. You can 

edit the warning message.  

3.9.2 Emergency stop button  

When this signal port active will trigger emergency stop alarm.  

3.9.3 Safety mode  

Safety mode used for machine maintenance mode, under which machine speed and 

laser power will all be restricted to preset safety range.  

3.9.4 Custom alarm  

User can assign any input port as alarm, edit alarm description and active level of 

signal port, and select allowed machine actions in alarm status.  

3.9.5 Allowed dual-drive error  

Maximum dual-drive position error allowed, the threshold to trigger alarm.  
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3.10 Common input  

 

Click  button and select controlled function and active level of input 

signal.  
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3.11 Common output  

 

3.11.1 Output configuration  

Aiming: output to control guide laser.  

Lasering: system will send an output signal for indicator lamp when laser in 

emission.  

Working: system will send an output signal for indicator lamp when laser in 

production.  

Alarm lamp: system will send an output signal for alarm lamp when alarm 

triggered.  

Alarm bell: system will send an output signal for alarm bell when alarm triggered.  

Ready: after machine axes returned origin, system will send an output.  

3.11.2 Auto lubricate  

After this I/O is assigned for auto lubrication, CypCut will start time/running 
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length counting and turn on/off lubrication when reach preset time/mileage interval.  

3.11.3 Custom output  

Assigned I/O will display software button under CypCut CNC tab. Custom I/O 

can select contact or self-lock control method.  

3.11.4 Regional output  

Regional output used for automatic dust extracting. When machine in production, 

laser head works in region A, output in region A will active and turn on dust extractor. 

When laser head works from region A to region B, output 12 turns off and output 15 

turns on.  

Turn-off delay: when laser head works from one region to another one, output of 

last region will turn off after preset delay. 

3.12 Find Edge Setting  

 

CypCut supports find workpiece edge by capacitance sensing and photo-electric 

senor. Photo-electric sensor must be Omron E3Z-L61 model. Capacitance sensing 

realized by BCS100 height controller. 
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3.13 BCP5045 Panel  

 

 

Enable BCP5045 panel in this page. In stand-alone environment, CypCut will 

connect to BCO5405 Mac address. In LAN environment, input ID of BCP5045. There 

are 12 custom buttons which can be assigned for machine function like PLC control or 

pallet control. 
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4. Electrical System Adjustment  

4.1 Power Supply Checking  

Connect BCL3724 I/O terminal board and BMC1214 control card by C62-pin 

cable, give 24V power supply to BCL3724 board. Make sure power supply in right 

wiring and no short circuit before power up.  

Note: Do not hot plug BMC1214 card and C62-pin cable!  

4.2 Basic Machine Motion Config Checking  

Motor runaway risk exists in close-loop control, you need to do some checking 

points before first-time running. 

First, confirm some basic settings in 'machine config tool' in below image: motor 

type, servo alarm signal polarity, pulse equivalent, encoder feedback, input gain of 

speed command, for dual-Y drive structure you also need to confirm rotation direction 

of master motor and slave motor in case of mechanic twisting (Take notice that servo 

drive parameters should be same settings for dual-Y axes). 
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Second, check motor direction and feedback pulse direction from encoder. Click 

 open ‘motor axis checking’ page. 

1. Click  to start motor runaway test.  

2. Click  option, then jog motor in both directions, if motor motion 

direction not same with command direction in CypCut, click  to 

reverse it.  

3. Pulse check. This is to ensure encoder feedback pulses and input gain of speed 

command set right. 
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4.3 Hardware Signal Checking  

Startup computer and open CypCut software. Open File tab > Diagnosis > IO 

Monitor.  

 

Check each signal one by one: positive limit/negative limit/origin switch of each 

motor axis, DA signal, PWM signal, servo enable signal and all other input and output 

signal.  
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4.4 Basic Motion Test  

First, set conservative PID value in servo driver. And set conservative value of 

motion control parameter in CypCut. In CypCut 'Layer' > 'Global Parameter' shown as 

below:  

 

Test single motor axis make sure pulse equivalent set right.  

After all limit and origin signal tested to work normally, execute each motor axis 

return origin to build mechanical coordinate.  

4.5 CypCut Basic Function Test  

On CypCut control panel(right side on screen), click direction button to jog 

control axes, lift up/down Z axis, turn on/off gas blow, open/close aiming laser, 

change laser burst power etc. to test each part function well. Confirm system can 

control laser, BCS100 height controller, gas and other devices function well.  

4.6 Position-Loop PID Self Adjustment  

In CNC tab > Auto adjust, to adjust position-loop PID parameter.  
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5. Adjustment Steps  

Servo drive 
setting

CypCut machine 
config

Motor runaway 
check

1.Select velocity control mode;
2.Set input gain of speed command;
3.Set encoder differential pulse 
output per motor revolution;
4.Velocity loop gain 75hz,time 
integral 9ms and set velocity loop 
rigidity level,
5.Confirm select external enable 
signal, doesn't set deadband signal, 
doesn't set rotation restriction.

1.Set motor type;
2.Set pulse equivalent;
3.Set encoder pulse output per motor 
revolution;
4.Set max motor rotation speed to 
10V.

Encoder 
feedback check

Self adjustment
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6. Common Problems in Close-Loop control 

6.1 Motor Runaway Error  

Error source: system doesn't receive feedback pulse or receive abnormal pulses from 

encoder. 

Checking points: 

（1） Check the wiring, make sure servo enable signal, speed command signal and 

encoder signal are wired with correct signal pin;  

（2） Check servo driver parameter: if set external enable, do not set deadband(neutral 

zone), and set zero offset value properly;  

（3） Check PID parameters in velocity loop and current loop, servo rigid level cannot 

be too low. 

6.2 Encoder and Speed Check Failed  

Error source: in process, program detected received encoder pulses and 

maximum speed doesn't match with preset value.  

Checking points:  

（1） If test results remain same error value in repeated testing, check servo driver 

parameter if command speed gain and feedback pulses match the setting in 

CypCut machine config;  

（2） If test results are different error value in repeated testing, encoder signal might 

be disturbed. Check in electrical cabinet if separate the wiring of strong current 

from weak current. 

6.3 Position Error Too Large  

Error source: the feedback position different with command position.  

Checking points:  
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（1） Open CypCut machine config, and execute make sure the 

checking passed; 

（2） If this error came after increasing acceleration in CypCut, might be caused by 

motor torque being restricted. Driver settings restrict motor torque or motor 

itself is of low torque type;  

（3） If this error came after increasing speed in CypCut, motor speed might be 

limited. Servo parameter might limit motor speed, or exceed motor maximum 

speed; 

（4） If this type error always exist when setting acceleration and speed from high to 

low level, it indicates servo system is of low rigid. Mechanic or driver inner 

loop is low rigid.  
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7. Optimize Machine Motion Performance  

7.1 Calculate Inertia Ratio and Preview Machine Performance 

Features  

The inertia ratio is a crucial indicator of machine performance features. You can 

calculate inertia ratio of each motion axis of machine by ServoTools. Download link 

is http://downloads.fscut.com/. ServoTools interface shown below:  

 

When inertia ratio is smaller than 200% machine runs in light load can reach 

high speed cutting. 

When the inertia ratio is between 200% to 300% machine runs in medium 

load, cutting precision is declined compared with light load in high speed, cutting 

speed and low-pass frequency should be lower. 
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When inertia ratio is between 300% to 500% machine runs in heavy load and 

cannot reach high speed cutting.  

When inertia ratio is larger than 500% indicating serious defect in machine 

design, servo system cannot complete adjustment in short time.  

You can calculate a rough value of machine maximum cutting speed, travel 

speed, and acceleration by ServoTools. The calculation results can be set in 

CypCut > Global Parameter > Motion Control parameter. Experienced users can 

calculate more accurate inertia ratio by servo tuning tool.  

Note: The servo parameters calculated by ServoTools only for FSCUT system of 

close-loop control card. Open loop control card should set servo parameter by 

position loop control mode.  

7.2 Motion Control Parameter Adjustment  

7.2.1 Motion control parameter description  

Speed, acceleration, low-pass filter frequency, corner and curve precision in 

FSCUT4000 system are available for users to adjust, other parameters related with 

motion control are optimized automatically. Parameter description listed below:  

Name  Description  

Travel Speed  The maximum travel speed. You can calculate by ServoTools and 

input calculated value directly.  

Travel 

Acceleration  

The maximum travel acceleration. You can calculate by 

ServoTools and input calculated value directly.  

Cutting 

Acceleration  

The maximum cutting acceleration which directly influences 

speed in cutting curve or corner path. You need to observe the 

torque curve in servo tuning tool to adjust acceleration in cutting.  

Low-Pass 

Frequency  

The filter frequency to suppress machine vibration. Suppression 

works stronger under smaller low-pass frequency value.  

Curve Precision  Curve cutting precision. Smaller value works higher curve control 

precision and lower speed.  

Corner Precision  The precision of NURBS curve fitting corner path. Smaller value 

works more pointed corner cutting but also slow the speed.  

7.2.2 Adjust cutting acceleration  

Jog axis at high speed, 500mm/s for example, make sure axis move enough 



 
FSCUT4000 Laser Cutting Control System  64 

 

distance to reach the pre-set speed.  

  Monitor the torque curve in servo tool when jog control the axis, increase the 

cutting acceleration if peak torque is under 80% of rated value, lower the cutting 

acceleration if peak torque is below 80% of rated value.  

Adjust the acceleration until peak torque reaches to 80% of rated value when jog 

the axis in high speed. The acceleration lead screw structure can bear is usually under 

0.5G. For rack gear structure is under 2G.  

7.2.3 Adjust travel acceleration  

You can calculate maximum travel acceleration by ServoTools. Or directly set a 

value 1.5~2 times larger than cutting acceleration. When machine running without 

load, motor peak torque should be under 150% of the rated value, and there should be 

no mechanism deformation or vibration under this acceleration. The acceleration lead 

screw structure can bear usually is under 0.5G. For rack gear structure is below 2G.  

7.2.4 Adjust low pass filter frequency  

You can adjust low-pass filter frequency (LPF) by cutting a part. Lower laser 

power and make a marking cut on workpiece. Observe the quality of marking contour. 

The marking graphic could be small circles in different sizes, hexagon, dodecagon, 

star shape and rectangle etc. As shown in the below image:  

 

Setup low pass filter frequency as high as possible as long as not reducing 



65 FSCUT4000 Laser Cutting Control System  
 
   

marking contour precision. The standard of contour precision should be no waving at 

corner position in cutting star, rectangular or polygon etc. You can setup by 

experiential value in below table. Setup the cutting acceleration then adjust LPF 2 

levels around. The cutting acceleration has to match with LPF, you cannot setup one 

of them too larger than the other one.  

Level  1  2  3  4  5  6  7  8  9  10  

Cutting 

Acceleration 

(G)  

0.1  0.2  0.3  0.4  0.5  0.6  0.8  1  1.5  2  

LPF (HZ)  2  3  4  5  5.5  6  6  6  7  8  

7.2.5 Curve precision and corner precision  

It's recommended to use the default value. If it's really needed, you can fine tune 

the value a little bit around the default value.  

If curve cutting precision doesn't reach requirement, you can lower the value, 

meanwhile cutting speed at curve also be reduced. Speed reduction is more obvious 

under smaller precision value. If corner cutting precision is not satisfied, you can 

lower the value, meanwhile cutting speed at corner also be reduced. Sharpe corner 

will turn to round corner under a large precision value.  
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8. FAQ  

8.1 Cutting is Slow or Jamming  

 In CypCut, open 'node mode' to view the drawing, if graphic contour made of 

a lot nodes, please optimize and smooth the graphic before cutting.  

 Check the cutting parameter setting see if there is improper setting of time 

delay, or mixed time unit set 200ms to 200s for example.  

 If Z axis jamming in lifting actions, check the BCS100 firmware version. If it's 

BCS100 V2.0, make sure firmware update to V802 and later version.  

 If it takes a long time for laser to start emission, check the serial 

communication of laser.  

8.2 Corner Over Burned  

 Raise the low pass filter frequency to reduce the acceleration and deceleration 

time at corner.  

 Raise the corner precision in global parameter to smooth the corner path.  

 Modify the drawing, for example, change the corner path like below image.  

 

 In layer parameter setting window, open speed-power regulating curve 

function, lower the laser power at low speed position.  

 Apply cooling point technique at corner position to cool off the heated zone 

then resume cutting.  

8.3 Laser No Emission  

1. Check Laser Setting in Machine Config  

 Check the laser type selection, for example, IPG YLS American version is 
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different with Germany version.  

 If use serial or Ethernet communication, check in PC if select correct 

communication port.  

 If use analog signal to control laser peak power, check if select right DA port.  

 Check if PWM and 'Laser on' signal select right I/O port.  

 

2. Check PWM and DA Output Signal  

 In CypCut > File > Diagnosis > Card Monitor input different DA and PWM 

value, then measure the voltage output at DA and PWM port in BCL3724 I/O 

terminal board. 

 If measured voltage is under pre-set value or no voltage output at all, try 

change another PWM or DA port then measure output voltage again.  

 If it's confirmed hardware error, please contact technical support.  

 

3. Check the Wiring  

 Check the wiring of PWM, DA, serial cable and other signal wiring with laser 

control.  

 Serial cable must have shielding layer and pin 2, 3 are crossed.  

 

4. Check Laser Status  

 Check laser status with laser software, test laser emission for trouble shooting.  

 When use serial communication, it's not allowed to use multiple software to 

communicate with laser at same time.  

 If serial communication failed, use debug mode to check command and laser 

response.  
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9. Appendix  

9.1 Fly Cut Operation Guide  

9.1.1 Function  

There are new functions for CypCut later than V6.3.495: ‘fly cut’ also named 

‘scan line cut’ in CypCut. This function applied in thin sheet cutting, used to cut 

arrayed parts of standard shape in high speed to improve production efficiency. 

Function entry shown as below.  

 

9.1.2 Function description  

Linear Fly Cut: select the rectangular array and create fly cut path. The fly cut 

path will be along same direction and laser head will not lift traveling between cut 

paths, meanwhile machine always maintain high speed in cutting.  

 

Circular Fly Cut: select arrayed circles and create fly cut path. The cutting will 

follow continuous path, laser head will not lift traveling between cut paths, meanwhile 

machine always maintain high speed in cutting.  
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9.2 Pitch Error Compensation  

9.2.1 Pitch error compensation description 

The mechanical error in ball screw and gear rack is an absolute existence, so the 

actual mechanic character is different with its nominal character. For application of 

high precision, it requires to measure mechanical error by measuring instrument like 

interferometer, then offset measured data via cutting control system to reduce 

mechanical error.  

CypCut laser cutting software designed complete compensation functions to 

create required machine actions for measuring device capturing data and offset error 

measurement data from interferometers of Renishaw, API, Agilent, OptoDyne etc. 

You can also set backlash error compensation directly if there is no interferometer 

measured data.  

9.2.2 Mechanical origin  

Before measure mechanical error must return axes to mechanical origin to build 

correct coordinate. CypCut takes origin point as reference to offset pitch error data. If 

the origin position is different before and after pitch error measuring, then pitch error 

offset cannot serve its purpose to reduce error even work in opposite effect.  

Use 'Z phase' signal to improve return origin precision. FSCUT4000 system 

provides encoder feedback channel for each motor axis to ensure control precision.  

Set return origin direction of X/Y axis by machine design. Return origin direction 

results in which coordinate quadrant machine runs with. If return origin towards 

negative direction, then machine runs in positive range of coordinate. If return origin 

direction towards positive direction, then machine runs in negative range of 

coordinate.  

You can repeat return origin and measure origin precision by interferometer. The 

error of each origin should be no more than 5μm.  

9.2.3 Measure pulse equivalent  

The theoretical pulse equivalent is different with actual value due to mechanical 
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error. Precise pulse equivalent can be measured by interferometer.  

 

9.2.4 Mechanic error measure  

In CypCut > CNC > Path function is to setup and create motion path for 

interferometer to capture and record measurement data. Machine runs and pauses in 

preset distance and time interval, meanwhile interferometer measures and records the 

actual position at each pausing point. After measurement complete will generate a 

data table of comparison between theoretical position and actual position.  

Most interferometers in market, take Renishaw for example, has to setup travel 

range, travel interval and time duration at each stop, like stop 1 sec every 30mm. 

Interferometer capturing data or not is decided by the interval distance and stop 

duration. First you have to setup several parameters: 

Range: the range to be measured, usually a little smaller than maximum machine 

travel range. 

Interval: by theory, shorter measure interval will get more precise offset result. 

Shorter measure interval will come with more stop points to be measured also take 

more time for a whole measurement process. Recommended interval is 

10mm~100mm.  

Stop time: the minimum stop duration for Renishaw is 2 seconds.  
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Make sure the zero point of interferometer and machine origin 

in same position.  

Check in CypCut machine config, pitch compensation function 

should be disabled while still in measuring process.  

 

9.2.5 Import measurement data to CypCut  

The measurement data file can be imported in CypCut. CypCut can read 

measurement file generated by Renishaw, API, Agilent, OptoDyne interferometer 

software. If the measurement file of interferometer you are using cannot read by 

CypCut, please contact our technical support. Below is where to import measurement 

file:  

Open CypCut machine config, in Machine > Pitch Compensation > Interferometer.  

 

Click  will open below window.  
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Click  to import measurement file of X axis, click  to import 

measurement file of Y axis. Imported file will be shown in data table and graph.  

If the coordinate polarity in data table is different with return origin direction, then 

compensation invalid.  

9.2.6 The operation steps of pitch error compensation  

1. Execute 'return origin' via CypCut;  

2. Setup the parameter in Interferometer software;  

3. Setup travel path in CypCut > CNC > Path;  

4. Execute measurement program for interferometer to capture data;  

5. Import measurement file to CypCut machine config;  

6. Execute 'return origin' via CypCut;  

7. Execute measurement program via interferometer again to check compensation result.  
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9.2.7 FAQ  

1. Pitch error doesn't change after compensation  

You need to execute return origin after import compensation file to let 

compensation data take effect.  

If the pulse equivalent is too small, for example, less than 200 pulses per 1mm, the 

compensation file doesn't work.  

 

2. Backlash larger after compensation  

If backlash gap became larger or even doubled, position error data might be offset 

in wrong direction. Click  to switch over positive and negative data 

group.  

This happened most likely when polarity of interferometer measure range and 

machine travel range not same.  

 

3. Data curves are symmetrical  

If the data curves of positive and negative direction are symmetrical in opposite 

direction, the polarity symbol of one of the data groups is wrong. This is rare 

situation, you can manually reverse the polarity symbol of positive or negative 

position error data group, then import file again. Or contact technical support.  

 


